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1 - About the i.MX35 ClockTree Tool 
This software tool was designed to help navigate the complex clock generation system of the i.MX35.  This is accomplished by 
providing a graphical interface to manipulate fields that control clock generation and apply pre- and post-constraints to the 
calculation of clocks.  The tool implements pre-constraint by not allowing values outside of an acceptable range to be entered 
for calculation.  Post-constraint is done by checking to make sure the calculated clocks fall within an acceptable range.  All these 
constraints are derived from the information available in the i.MX35 reference manual (and Errata to i.MX35 Reference Manual 
Rev. 2), and datasheet.  The purpose of this tool is solely to aid with calculation, and any calculations should be validated for 
application-level development.  Any settings generated by this tool should be checked against the latest reference material from 
Freescale before being used in any application.  Additionally, some of the modules present in the i.MX35 may be missing or 
incomplete in the Beta version of this software. 

DISCLAIMER: This software is for evaluation purposes only, all information provided must be validated with the most recent 
documentation available from Freescale  
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2 - Getting Started 
To begin using the software, first run the supplied installer and follow the on-screen instructions.  After installation, a shortcut 
for the tool will be placed on the desktop and in the Start Menu under All Programs >> i.MX35 ClockTree Tool.  Start the 
application using either of these shortcuts, and the window shown below in figure 1 should appear. 

A

 

Figure 1 - i.MX35 ClockTree Tool Home Page 

This is the home page first page displayed when the i.MX35 ClockTree Tool software is run.  All controls are disabled by default, 
and the “Begin” button (Item A in the above figure) must be clicked before the tool can be used.  Once the button is clicked, 
after a few moments the tool will be fully initialized and ready for use.  The home page will be removed, and the tool will look 
like figure 2. 
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2.1 - Expanded View 
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Figure 2 - i.MX35 ClockTree Tool Initialized View 

The expanded view of the tool shows the tab pages (Item A) used to navigate among the different i.MX35 modules and modify 
settings, a set of block diagrams (Item B) for each of the clocks in the module being used, and an output area (Item C) that is 
used to show the register and field values and show error messages for violated constraints (Item D).   The block diagram and 
output areas are explained in the following subsections, and the tab pages are explained later in the “Detail Operation” section. 
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3 - Panels 
 

3.1 - Output Panel 
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Figure 3 - i.MX35 ClockTree Tool Output Area 

The output panel provides detailed information on the register values that correspond to the selected settings in the tool.  
Clicking on a module name (Item A) opens the module, displaying all the registers.  Each register shows the name (Item B), 
absolute address (Item C), and hexadecimal value (Item D).  All values are displayed as 32-bit, and in the case of register that are 
smaller, the value is padded with preceding 0’s to form a 32-bit value.  Clicking on a register name (Item B) opens the register, 
and displays the bit-fields it contains.  Each bit-field is named (Item E), and the bit location is given (Item F).  Any bit-field in a 
listed register that is not associated with clocking is given its reset value.  Values in the output panel may be selected and copied 
for use in a debugger or other file.  In addition to register information, when a constraint on a clock is violated the clock output 
field is highlighted, and the description of the violation is displayed at the bottom of the output area (Item G).     
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3.2 - Block Diagrams 
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Figure 4 - i.MX35 ClockTree Tool Block Diagrams 

The block diagrams provide a graphical representation of each clock in a given module.  While it does not necessarily show the 
arithmetic relationship of the modifiers, it gives the general logical flow of the calculation.  The tags on the left (Item A) show the 
name of the source clock (or clocks) used.  When a field is selected in the tab page, the corresponding block in the diagram is 
highlighted (Item B) to help visualize what is being modified.  Different types of modifiers are represented differently: standard 
dividers or scalars are shown as rectangles with the modifier name, if a number is also given below the name (Item C) then it is a 
fixed modifier, and the value cannot be directly changed.  Muxes are represented by the standard symbol (Item D) with the 
modifier name shown as the selection input.  It is important to note that the diagrams shown change based on the module being 
edited, not the tab selected.  For instance the CCM module is spread out across the PLL, Clock Gen, and Clock Out Tabs, but the 
same set of diagrams (for the CCM) is displayed no matter which of the three tabs is open. 
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4 - Menus 
The menu at the top of the tool window consists of File, Tools, View, Help, Calculate, and a Navigation Menu.  This section 
describes the features available in each of these menus, and how to use them. 

4.1 - File Menu 

B

A

 

Figure 5 - i.MX35 ClockTree Tool File Menu 

4.1.1 - Saving/Loading Settings 
The settings used in the tool can be saved to and loaded from a file.  To save the settings currently being used, go to File >> Save 
(Item B).  Specify a file name and location in the pop-up window, and click “Save.”  A saved file can then be loaded by going to 
File >> Open (Item A).  Only files saved by the same version of the tool may be opened unless otherwise noted.    In the Beta 
version of the tool these files are saved using a .clk extension.  These files should not be edited externally, as this may cause 
unstable operation of the tool. 

In addition to using the File >> Save button, whenever the program is closed, either by clicking the “X” at the top or with File >> 
Exit, you will be asked if you wish to save before the program exists.  In the Beta version, this prompt is given every time the 
program closes, regardless of whether any changes have been made in the tool. 

4.2 - Tool Menu 

A
B
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Figure 6 - i.MX35 ClockTree Tool Tools Menu 

4.2.1 - Generating Reports 
The tool also has the ability to generate detailed reports by going to Tools >> Generate Report (Item A).  Specify a file name and 
location in the pop-up window, and click “Save.”  The Beta version of the tool will generate a report file in a .txt format.   A 
report contains all the current settings and calculated values, organized by module.  
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4.2.2 - Device Reset 
Selecting Tools >> Reset (Item C) resets all register and modifier values to their out-of-reset values as determined by the 
reference manual.  Note that these are the hardware reset values, and may be modified by software such as the boot ROM.  

4.2.3 - User Constraints 
The user may set their own constraints on any of the clocks by specifying a minimum and maximum value the clock should be 
between.  If there are device-level minimum and maximum values given, then the user values must be within that range.  If a 
value greater or less than the corresponding device limit is entered, the device limit is automatically used instead.  It is important 
to note that in the Beta version only a small number of device-level constraints are implemented.  User constraints may be set 
by going to Tools >> User Constraints (Item B), this will open the window shown below in figure 7. 

A B C D E

 

Figure 7 - i.MX35 ClockTree Tool User Constraints Window 

The User Constraints window shows a clock on each row with the name of the module it’s in (Item A), the clock name (Item B), 
the minimum value (Item C), the maximum value (Item D), and the units the values are in (Item E).  The minimum and maximum 
values can be changed by clicking in the cell you wish to modify, and typing in a numerical value.  Be aware that the value must 
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be in terms of the listed units.  For example, if a maximum of 600MHz is desired for the MPLL, the value entered in the 
“Maximum Value” cell should be 600000000 since the units are Hz. 

4.3 - View Menu 

A
B

 

Figure 8 - i.MX35 ClockTree Tool View Menu 

The View menu allows you to select what sections are viewable in the tool.  View >> Block Diagram (Item A) controls the visibility 
of the block diagram, and View >> Output (Item B) controls the visibility of the output area.  Both are visible by default. 

4.4 - Help Menu 
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Figure 9 - i.MX35 ClockTree Tool Help Menu 

Under the Help menu, general tool information, such as the version number, is available using Help >> About (Item B).  Selecting 
Help >> Advanced Information (Item A) will bring up an information window like the one shown below in figure 10. 
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Figure 10 - i.MX35 ClockTree Tool Advanced Information Window 

The left column of the window displays information about the clock such as the name, parent module, current value, and 
current source, possible sources (Item A), and associated modifiers (Item B).  Clicking on the name of a source clock will display 
the information for that clock, and clicking on a modifier name will display that modifier’s information in the right column of the 
window.  The information displayed for a modifier includes the name, type, current value, reset value, parent register, and 
possible values (Item C).  Besides clicking on source clock names, the information window may be navigated by first selecting a 
module (Item D) and then a clock within the module (Item E).  In addition to being accessible from the Help menu, any clock may 
be directly accessed in this window by right-clicking on the clock name within the tab page and selecting “Advanced 
Information” from the menu. 

4.5 - Navigation Menu 

A

 

Figure 11 - i.MX35 ClockTree Tool Navigation Menu 

The navigation menu provides a quick alternative to select which tab is active.  The drop-down menu (Item A) lists each of the 
tabs in alphabetical order.  When a tab is selected in the drop-down, it is automatically selected as the active tab in the tool. 
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5 - Pages 
 

5.1 - Subpages 
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Figure 12 - i.MX35 ClockTree Tool Sub Pages 

In some cases, there are multiple instances of a module, such as shown above in figure 12 with the UART.  When there are 
multiple copies of a module, then subpages are used for each instance.  Settings common to all the modules are shown in the 
upper portion of the page (Item A), and then a separate sub-tab (Item B) is shown for each instance of the module. 
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5.2 - MPLL Back-Calculator 

 

Figure 13 - i.MX35 ClockTree Tool PLL Back-Calculator 

The PLL Back-Calculator tab provides a way to find the necessary register values based on a desired PLL output frequency.  This 
desired frequency is set using the “Desired Frequency” menu (Item A), which allows selection of a decimal value between 133 
and 1000MHz.  The “calculate” button (Item B) uses the requested frequency along with the crystal frequency provided on the 
main PLL tab to calculate the settings needed to provide the desired frequency.  Since there a multiple options, up to 11 are 
provided (Item C) based on the model of using higher values for the MFN and MFD fields.  After selecting the desired settings by 
clicking on the list of values, the “Use Selected” button (Item D) can be used to automatically load the generated values in for 
the MPLL settings on the PLL tab. 
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6 - Detailed Operation 
This section further explains what the different controls mean, and how they are used in calculating clock values.  Additionally, 
the modules and clocks that are made available in the tool are listed.  

6.1 - Modules 

 

Figure 14 - i.MX35 ClockTree Tool Navigation Tabs 

The tabs seen in figure 14 allow navigation between the different modules.  As mentioned in the previous section on subpages, 
some tabs have sub-tabs since there are multiple instances of that module.  These include ESDHC, SSI, UART, CSPI, I2C, CAN, 
EPIT, and GPIO.  Due to its complexity, the CCM is broken down into three separate tabs: PLL, Clock Gen, and Clock Out.  The PLL 
tab contains the PLL and external clock sources, Clock Gen contains the root clock generation, and Clock Out is used to configure 
the CLKO functionality.  A complete list of all available modules is given below in table 1.  A comprehensive list of all clocks 
grouped by module is available in appendix A. 

CCM CAN_2 NFC AUDMUX 
UART_1 OWIRE WEIM USB 
UART_2 PWM ESDHC_1 FEC 
UART_3 GPT ESDHC_2 WDOG 
CSPI_1 EPIT_1 ESDHC_3 KPP 
CSPI_2 EPIT_2 SPDIF IIM 
I2C_1 GPIO_1 SSI_1 IOMUX 
I2C_2 GPIO_2 SSI_2 IPU 
I2C_3 GPIO_3 ESAI ATA 
CAN_1 eSDCTL ASRC  

Table 1 - i.MX35 ClockTree Tool Modules 
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6.2 - Using the Tool 

 

Figure 15 - i.MX35 ClockTree Tool PLL Page 

The PLL page, shown above in figure 15, is the first page visible after the tool initializes.  Each page is broken down into the 
clocks it contains.  Each clock is a grouping titled with the clock name followed by the module name in parentheses (Item A).  
The first item listed in a clock group is the name of the current clock source (Item B).  When the source changes due to a setting, 
this field is automatically updated so the current source is always displayed.  Below the source name are any modifiers 
associated with the clock (Items C and D in this example).   

The Frequency modifier (Item C) is an example of an external clock source.  The fact that it is an external modifier is denoted by 
the light blue background and the “[pins]” tag immediately following it.  An external clock source works by setting the frequency 
(in MHz, up to three decimal places) in the box.  The allowed frequencies may be constrained based on device limitations.  If a 
value outside of the allowed range is entered, it will automatically default to the closest allowable value.   
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The next modifier, CLK_MOD, is an example of a pin-based modifier.  Again the coloration and tag denote that it is an external 
modifier, but in this case it corresponds to a set of external pins whose state affect the clock’s value.  The drop-down menu lists 
the state of the pins followed by a description of the effect.   

The final item shown in a clock group is the current value of the clock (Item E).  The value is shown along with the units, and is 
updated when the “Calculate” item on the menu is clicked.  A more common modifier is shown with the MPLL’s BRMO field 
(Item F), which simply corresponds to a field in a register. 

6.3 - Example Use-Case 
This example shows how the tool could be used to configure an i.MX35 for a 400MHz MPLL using the default crystal, 500kHz 
CAN settings using a 16MHz audio crystal, and a watchdog timeout of 1.5 seconds.  After starting the tool, navigate to the PLL 
Back-Calculator tab, as shown below in figure 16. 

6.3.1 - Solving for the MPLL Settings 

A

B

 

Figure 16 - Example: Back-calculate for 400MHz MPLL 
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We are assuming the default 24MHz crystal is being used, and we want a 400MHz frequency for the MPLL.  Enter “400” in the 
Desired Frequency field (Item A), and then click on the Solve button.  A list of solutions will appear, and you may then select the 
one you wish to use by clicking on it (Item B).  After a solution has been selected, click the Use Selected button to have those 
values automatically be entered for the MPLL settings and be taken back to the PLL page as seen below in figure 17. 

6.3.2 - Recalculating the MPLL Frequency 

A B

 

Figure 17 - Example: Recalculate MPLL and confirm 

When the page loads, notice that the MFN, MFD, MFI, and PD fields have all been set with the values from the selected solution 
(Item A).  In order to apply these settings and recalculate the MPLL, click the Calculate button in the menu at the top.  Once the 
MPLL is recalculated, the desired frequency of 400MHz should be displayed (Item B).  If the displayed result does not match the 
frequency that was used in the back-calculator, be sure that the crystal frequency was not changed after calculation, and that 
the MPLL settings were not accidently altered after being set via the Use Selected button. 
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6.3.3 - Changing the Audio Crystal Frequency 

A

 

Figure 18 - Example: Changing the Audio_Crystal frequency to 16MHz 

The next step in this example is to set up a CAN module for 500kHz operation.  The default clock source for the CAN module(s) is 
the Audio_Crystal (Item A), so we will set this to a common integer crystal value of 16MHz.  After entering “16” in the Frequency 
field, click Calculate to update the tool using the new value (Note: since the tool only recalculates when the Calculate button is 
clicked, it is recommended to do this after any important change to the settings).  After confirming that the Audio_Crystal is 
16MHz, navigate to the CAN tab, as seen below in figure 19.  



i.MX35 ClockTree Support Tool User’s Guide [BETA]  

     18 
 

6.3.4 - Setting up CAN for 500kHz Operation 
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Figure 19 - Example: Setting up CAN_1 for 500kHz Operation 

The i.MX35 has two CAN modules, for this example only the CAN_1 module will be set up for the 500kHz operation.  First 
confirm that the CLK_SRC field (Item A) is set to use OSC_Audio as the clock source .  According to OEM spec for 500kHz 
operation with a 16MHz crystal, the following values are used:  PRESDIV = 2 (Item B), PSEG1 = 4 (Item C), PROP_SEG = 8 (Item D), 
and PSEG2 = 3 (Item E).   After entering those settings, clicking the Calculate should recalculate the bit_rate (Item F) for CAN_1 
to show the desired 500kHz.  For the last configuration in this example, navigate to the WDOG tab as shown below in figure 20.  
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6.3.5 - Changing the Watchdog Timeout 
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Figure 20 - Example: Changing the WDOG timeout to be 1.5 seconds 

The WDOG module uses the ipg_clk_ckil clock as its source (32kHz, derived from the OSC_24M).  Since the WT field is not simply 
a divider or MUX, the relating equation is given in the block diagram area (Item C).  The default WT value of 1 provided a time-
out of .5s, which is 1/3 the desired time-out.  Looking at the equation, multiplying both sides by 3 would give the desired time-
out, and the WT field can simply be tripled as well.  After entering  3 for the WT field (Item A) and clicking Calculate, the desired 
value of 1.5s should be shown (Item B). 
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6.3.6 - MPLL Settings Register 

A

 

Figure 21 - Example: Copying the register settings for the 400MHz MPLL 

Now that all the settings have been made for the desired configuration, the corresponding register values for the clocking can be 
copied for use in scripts or debuggers.  For the 400MHz MPLL, open the CCM module in the output panel, and then the address 
and hexadecimal value (Item A) for the MPCTL register (which controls the MPLL’s frequency) may be selected, and then copied 
using Ctrl+C. 
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6.3.7 - CAN Settings Register 

A

 

Figure 22 - Example: Copying the register settings for the CAN_1 module 

Similarly, opening the CAN_1 module in the output panel shows the CTRL register, which controls the timing for the CAN_1 
module.  The settings (Item A) may be selected and copied in exactly the same way as the MPLL settings were.  It is important to 
note here that the provided register settings only configure the timings for the CAN_1 module.  Other registers, and other bit-
fields in registers provided by the tool, may need to be configured to fully set up the CAN_1 module for operation. 
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6.3.8 - Watchdog Settings Register 

A

 

Figure 23 - Example: Copying the register settings for the 1.5s WDOG timeout 

Finally, opening the WDOG module in the output panel shows the WCR register, which controls the WDOG’s time-out value.  The 
settings (Item A) may be selected and copied in exactly the same way as the MPLL settings were.  Again it is important to note 
that this is only the time-out register for the WDOG, and other registers and bit-fields must be configured for the WDOG to be 
operational. 
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